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QSoft Imaging

Introduction

QSoft Imaging allows the camera operations to be tested without having to run any other QSoft
application.

Run QSoft Imaging

To run QSoft Imaging - double-click the QSoft Imaging icon on the Windows® desktop.

]

GSoft
Irmaging

Figure 1: QSoft Imaging Icon

If the icon is not present on the Windows desktop, it can be located from the Start menu under
Programs\Genetix .

The screen below will be displayed.

= QSoft Imaging
File Tools Fiters View Help

&|H| &|=| %[ 2| &seler] 4|0 | zoom [0 ] FrameGatber [0T320 | T ShentE [ 00—

Left Click’ circled colonies for Propertiss or Right Click for contest menu.. |50, v-0  31/08/2004 1640

Figure 2: QSoft Imaging Screen

NOTE - Before using QSoft Imaging, select the correct frame grabber from the drop down list on
the toolbar.

If an error message appears whilst trying to take a picture it is probably because the wrong
frame grabber has been selected — check your hardware configuration or contact Genetix
Customer Support.

If unsure about which frame grabber is installed in your PC, check this as follows:

* Run another QSoft application (such as Picking).
* From the View menu select Configuration.
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[M] Robot Configuration gl

Hardwiare ]gase Classes | Datum Paints | Definec Ohjects | Database |

At
Egrlv\l‘;guratinn' | J JJ
Py

=145 OPix Robot

=11 Camers
= Bed
& Dryer
LightBiox
&F [P Bath #1
& OPix Bath #2
& OFix Bath #3
[ U Drive
= @ Consumables Collection (D ummy)
s 9B Pin Picking Head
W Fiter Block
[77] Genetix Binassay Tray
B Genetix 304 F Wwell Plate 6000
= Stacker Dest Plate Holder
== Diives Collection [Dumrmy]
= % Diive

= Y Diive:
= Z Diive
= Stacker Collection
E_ QTrap Stacker v

Properties | Refresh | Usze | Remove ‘

Licence Robot Hame Ok

Figure 3: Hardware Configuration

* From the Hardware tab highlight Camera and click the Properties button.

¢ Scroll down the list of camera properties to the value alongside the FrameGrabber
property.

The Menu Options

QSoft Imaging contains drop down menus that can be accessed by pointing with the mouse and
clicking the left mouse button.

File Menu
The File menu contains facilities for file operations

Open — Allows an existing image file to be opened. A standard Windows file-open dialog will
appear where the location and name of the image file can be specified.

Save As — Allows an image file to be saved. A standard Windows file-open dialog will appear
where the location and name of the image file to be saved must be specified.

Tools Menu
Picture — The camera will take a still image.

Live Video — The camera will be put into live mode. The purpose of this is so that you can adjust
the lens aperture and focus.

Locate Colonies — The image will be processed and good colonies will be outlined in green.

Note: Green is the default color for a selected colony. The color can be changed by selecting
Colors from the View menu.
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Filters
The options here allow manipulation of the image in order to improve colony finding.

If any of the filters are applied, ‘Locate Colonies’ will need to be selected to update the image.

View Menu

Tools

This option will display a dialog that allows the selection criteria and/or threshold values to be
refined.

Criteria
These variables define the size, proximity and shape of the colonies that will be picked.

Tools §|

Criteria llhreshold] ﬁarcodel Eameral

Include Colokies

Mir: Mai

Diameter: j IE j‘
Roundness: 080 ill

Aniz Fatio: 0.80 j

Prowinnity: v l—g j
Spot Overlap: I—E j
Halo' Colanies anly: I

Mucleus Fatio: l— j

[ Show Calarw outine az Circle

Picture | FIe-F'rocessl Diore

Figure 4: Tools Criteria

Diameter — Set the minimum and maximum area (in pixels) of the colonies.

Roundness — Set the minimum roundness of the colonies. This is a ratio of the circumference of
a perfect circle (taken from the measured radius of the colony) divided by the actual
circumference of the colony. For a perfect circle, the value would be 1.00. A typical value is
between 0.80 and 0.95. Only colonies with a roundness greater than that set will be picked.
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Axis Ratio — The axis ratio is found by dividing the shortest axis by the longest axis. For a
perfect circle (or square) the value would be 1.00. Typical values would be between 0.60 and
0.90. Only colonies with an axis ratio greater than the set value will be picked.

Proximity — The facility has two settings, the first is a checkbox to turn it on or off, and the
second allows the setting (in pixels) to be varied, when enabled.

If the distance between the outer edges of two colonies (based on them being perfect circles,
derived from their maximum radii), is smaller than the value set for the proximity detection, they
will both be rejected as being too close.

Spot Overlap — Because the total image of the tray is made up of 35 frames, in order not to
miss any colonies, the frames have to overlap by a small amount.

There may be occasions when an individual colony occupies one of these overlap areas, and so
could be identified more than once. If it were present on the very corner of a frame, it might be
"seen" in up to three other frames, making a total of four identified “good” colonies. However, the
software is designed to recognize instances such as these and pick multiple identified colonies
only once. There are however slight problems with exactly matching a colony seen in one frame
to the same colony seen on an adjoining frame, so this setting allows for a certain amount of
mismatch between the frames. Typically this is set to about 20 pixels.

Halo Colonies Only - If this option is checked, only halo colonies will be picked.

Nucleus Ratio - If halo picking is enabled, the nucleus ratio may be used to set the percentage
ratio between colony and halo area. Below this ratio, a colony will be rejected.

Threshold

A Threshold value is a grey value, between 0 and 255 (0 being the value for black and 255 for
white) which enables the software to distinguish between the background and foreground
features of an image. To distinguish between agar and colonies, the range of grey levels that
represent the agar (background) should be excluded from the image. The range of grey levels
that represent the colonies should be higher than the threshold range.

Where the image data is uncomplicated, it is advisable to use the automatic thresholding. This is
quicker and simpler to set up.

Tools ﬁ‘

Lriteria  Threshold ]Earcnde] Eamera]

Threshold Y alues
e

128 [ 2= show
Min Average Grey: 1 j
" Automatic
Threshold Values: =L =
= =
fcfust by % =

Histagram

Grey: 228

Refresh
Zoom |n
Zoorm Dut

0 [Use L/R mouze buttons to set threshold) 255
Flot Line: [Grey at Point: 85)

> j
-
Picture | Fe-Pocess | Dione

Figure 5: Tools Threshold

www.genetix.com @ @ @ Page 7 of 20



GENETIX > COLONY PICKERS QSOFT UTILITIES USER GUIDE

Manual

Center Frame - These two values are used to set the minimum and maximum threshold for the
background at the center of the QTray, which is to be picked. The lower and upper limits for
center frame threshold define a range of pixel grey levels that will be considered “background” or
agar.

For normal “White” or “Blue” colony picking, the lower threshold must be set to zero, and the
upper threshold should be varied to correctly exclude background pixels. Typically, the upper
threshold will be a value between 160 and 220. Its limit is 255.

For “phage” picking, the lower center frame threshold should be varied, and the upper threshold
should be set to 255.

Automatic
Threshold Values - Software-calculated threshold values based on each frame.

Adjust by % - A global parameter which allows the automatic threshold to be to fine-tuned. This
parameter allows the upper calculated automatic threshold value to be sharpened or softened,
the typical range is +10% to —10%.

Show - When this button is clicked the screen will differentiate between the thresholds by
turning the background to black.

Now, the threshold values can be “fine-tuned”. The image screen now has a horizontal red line
running across the center of the image. By adjusting the values for Center Frame , the threshold
values on the screen will change.

When picking White or Blue/White colonies, the ideal is to have a black background and white
colonies, with good definition between the two.

Once the thresholds have been set click on the Picture button to ensure that the new threshold
values are correct. The robot will take a new picture and display the results on the screen.
Colonies circled in green are “good” (if default colors are set) and those circled in red are “bad”
(assuming default colors are used). Review these results; if they are acceptable continue by
clicking the OK button, if not repeat the thresholding process.

Histogram

Hiztagram

Grey: 255

BRefresh

Zoom [

i

Zoom Dut
0 [Usze L/R mouze buttons to zet threshold] 285

Figure 6: Threshold - Histogram
The Histogram shows the volume of grey pixels in the image by value. The left of the Histogram
represents black pixels whilst the right of the histogram represents white pixels.

Typically you would expect to see one large peak in the histogram, which represents the grey
scale of the agar in the image.

If there is a large population of colonies you may see a second peak in the histogram, which
represents the grey scale of the colony data.
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The histogram can be used for setting the Manual Threshold parameters. Click, using the left
mouse, in the Histogram to set the Min threshold level and click, using the right mouse button, to
set the Max threshold level.

For typical E-coli plates the Min threshold should be set to zero (0) and the Max threshold can be
set by Right clicking just to the right of the first major peak in the Histogram.

Refresh — Occasionally, when re-taking images in the Test Image screen the histogram data
may not update the Histogram window. In this case clicking the Refresh option button will correct
this.

Zoom in/Zoom out — If there is little color contrast between the Colonies and the Agar the
Histogram data will appear very flat and no obvious peaks are displayed. In this instance, use
the Zoom In/Out options to alter the scale of the graph to better identify the peaks.

Plot Line

Plat Line: [Grey at Paint; 176)

j
Figure 7: Threshold - Plot Line

The graph in the Plot Line window represents the red line that pans up and down the image
window. Click on the scroll buttons to move the red line and as it passes over colonies peaks will
appear which describe the intensity of each colony.

Barcode
This tab is displayed if barcodes are read using the camera.
Tools E\
Qriteria] Threshaold Barcode ] Camera]
Options
Type:
Cenitre Onily: r
Picture | ReProcess | Done

Figure 8: Tools Barcode

Type — Select the barcode type from the drop-down list.
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Center Only — Where more than one barcode may be present check this option to ensure that
the one nearest to the center is read.

Camera
Tools E|

Qilerial lhleshold] Barcode Camera l
Fange

Black: 44 j

‘white: 141 ﬂ

Unifarrity Transfarm

[v Apply Uniformity Tramsform

|C:\Test Image.bmp Browse. ..

Picture Re-Process Daone

Figure 9: Tools Camera

Set the required brightness and contrast values here — the default values are determined by
which frame grabber is in use.

Apply Uniformity Transform  — This is used for correcting certain anomalies in images taken by
a digital camera.

Properties
Displays information about the currently selected colony — see example below.
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Colony Properties

SUMMARY:
Tatal Colonies: 42
Selected Colonies: 13
DISCARD: True
Dizcard Reason:  Axiz Ratio
COLONY:
Ave Diameter: 1063853
Area: a2
Auiz Ratio: 0.7073582
Roundness: 0.8150597
Perimeter: 35.58625
Avwe Grey [C]: 162 77FFTTFvTTTe
Ave Grey [T]: 1443415
HALD
Area: a2
Colory Ratio: 100%
# Centroid(T]: 205,801
Y Centroid(T]: -352.6302

Figure 10: Colony Properties

Crosshair

The red crosshair symbol represents the center of the camera. Jog the camera by moving the
drives by hand to improve accuracy.

Colors

Colonies are outlined according to a color code associated with the discard reason. Select this
option to change these colors.

Toolbar
Displays or hides the toolbar.

Status Bar
Displays or hides the status bar.

Other Toolbar Options

Define ROI — Allows an area that represents valid background data to be defined. Use this
option when an image contains obstacles such as the edge of a Petri dish or bioassay tray. For
detailed information about Threshold Region of Interest, see the Picking manual.

Zoom - The zoom control allows digital magnification of the image.

Grid — Checking this box displays a grid over the image which can be helpful when aligning the
camera/CCD in Test Image mode. The grid size can be altered (in steps of 10 pixels) as required
using the up and down arrows.
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QSoft IO Manager

Introduction

This utility allows all of the mechanical inputs and outputs on the robot to be viewed and to
switch outputs on or off as required.

Run QSoft IO Manager

When the 10 Manager utility is installed, this icon should be displayed on the Windows desktop.

GSaft 10
t anager

Figure 11: QSoft IO Manager Icon

Double-click the QSoft IO Manager icon.

If the icon is not present on the Windows desktop, it can be located from the Start menu under
Programs\Genetix .

The first time the utility is run a series of prompts will appear to determine which robot you are
using.

(Soft 10 Manager

\;:) Is the attached robot & QBot?

Figure 12: Robot Type Message

When the prompt shows the robot type, click the Yes button.
If No is the answer to all of the prompts, the message below will be displayed.

QSoft 10 Manager

‘j ¥ou haven't selected a 'Robot Type',
*

Select Yes to bry again or Mo to exit this program,

Figure 13: Robot Not Selected Message

Click the Yes button to cycle through the robot types again or click No to exit QSoft IO Manager
without selecting a robot type.
The QSoft IO Manager screen will look similar to the one shown below.

The names of each output and input are listed alongside the 1/0 address.
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£ QSoft IO Manager:

1/0 Board Type:

Outputs:
Light T able

Rearraying ' alve
L Light

Fan

Boost Outputs:

Alternate:

Alternate Dutput:

Ihputs:

Lid Up
Lid Doy

2005 @

Light Table

@
‘@
i@
‘@
5@
E@
@
i@

QSOFT UTILITIES USER GUIDE

" Advantech PCI1730: ”

Grabber L ]
Lid Sucker 10
Plate Holder @
Rotate Plate 12
Lid Up/Dawn 134
Actuator Air 14
InUse 15
Alam 16

2006 @

-

Fotate [Lid] 9@
Rotate [Plate) 10
Plate Locked 1@
Plate Unlocked 12
Mid Lift 3@
Power 14 @
EStop 15
Doar 16 @

Click outputs to toggle state, press F2 to edit/zave descriptions

7@
15
19
0@
A
2@
@
4@

2007 @

Delay Ims]: [0 =

7@
1@
19@
0@
@
2@
2@
4@

Start

[¥] = Input/Output on Second Controller

3

il
@
7@
n@
2@
NG
@
2@

2000 @

5@
x@
@
2@
2@
0@
@
2@

Done

Figure 14: QSoft IO Manager

I/O Board Type — To determine which board(s) are installed on your PC:

* Run another QSoft application (such as Picking).
* From the View menu select Configuration.

www.genetix.com
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[8] Robot Configuration E|

Hardware ]Ease Clazzes l Datum Paints ] Defined Objects l Databaze l

Active | JJJ

a? Diyper
LightBox
&P [P« Bath #1
& [JPix Bath #2
&F [Pix Bath #3
[l] U Drive
= @ Consumables Collection [Dummy)
@ 96 Pin Picking Head
. Filter Block
Genetix Bioaszay Trap
Genetiz 384 F Well Plate >6000
% Stacker Dest Plate Holder
== Drives Collection [Curnmy)
= ¥ Drive
= Y Drive
= Z Drive
= Stacker Collection
E_ QATray Stacker v

Froperties | Refresh | Usze | Remaove |

Licence | Hobotﬂame| ak

Figure 15: Hardware Configuration

* From the Hardware tab highlight the Robot name and click the Properties button.
¢ Scroll down the list of camera properties to the value alongside the IOController property.

Note: A second IOController might be installed if t he robot has stackers or additional
hardware options. The property name for this is IOC  ontroller2.

Outputs — You can control the outputs by clicking the required indicator light. The indicator light
shows red when the 1/O is off and green when the 1/O is on.

Boost Outputs — These outputs are for calibration purposes and only to be used by a Genetix
engineer.

Alternate — Set options in this section in order to alternate the state of an output between on and
off.

Alternate Output — Select from the list which output is to be tested.

Delay (ms) — Select the time delay from the drop-down list. The output will remain in each state
(on and off) for the specified time (100 ms — 1 second)

Start/Stop — Click the Start button, the output will alternate between on and off states. Click stop
to end test.

Inputs - You cannot control the inputs, these are for information only.

The labels can be edited if necessary. Press the F2 key, text windows will open for each label.
Press F2 again to save the edited descriptions.
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QSoft Restacker

Introduction

The QSoft Restacker utility allows the WellPlate Stackers and/or the QTray stackers (if fitted) to
be operated without having to run any other QSoft application.

This can be used for re-ordering plates after running another QSoft application or for reading
barcodes on plates and trays in preparation for an application run.

QSoft Restacker will send plates from the feed stack to the robot bed, read the barcodes (if this
option has been selected) and then, after a short pause, each plate is sent to the return stack.

When all plates have been restacked QTrays are fed out on to the bed one at a time, the
barcodes are read (if this option has been selected), each tray is then returned and the stack is
positioned ready for the next pair of trays to be loaded.

ReStacker Software

When the ReStacker utility is installed, this icon should be displayed on the Windows desktop.

LE

QSoft
Restacker

Figure 16: QSoft Restacker Icon

Double-click the ReStacker icon.

If the icon is not present on the Windows desktop, it can be located from the Start menu under
Programs\Genetix .

Configuration and Diagnostics

These buttons are described in detail in the robot manual.

WellPlate Stacker

QSoft will check how many plate stackers are configured for the robot and how many stacks are
on each stacker. Each stack is represented on the form by a check box.
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_tE QSoft XP ReStackers K

File Wiew Help

@ G

Wizlcome Wellplate Stacker | GiTray Stackar] Start 1

- Select Stack[s) in use

r

- Enter number of plates loaded in each stack

w

- Select 'Read Barcodes' if barcode reading is required.

S

- If reading barcodes, select the cornect plate type being
used in the stacker.

2]

- |f barcode validation is required, use either the Barcode
buttan far each stacker lane or the Import button to load
the validation barcodes.

‘wellPlate Stack 1 ~ Nurber of Plates Loaded: |70 ﬁ Barcodes

‘“wellPlate Stack 2 i Number of Plates Loaded: |70 j Barcodes
‘wWellPlate Stack 3 I Humber of Plates Loaded: |7 —:—_ll Barcodes
Copy | Irnpart I

Plate: A0, BI0. 96 DEEP WELL PLATE |

Select Options 03-02-2004

Figure 17: WellPlate Stacker Options

WellPlateStack n - Check the box alongside each stack to be restacked. Stack 1 is always
nearest the front of the robot.

Number of Plates Loaded - Enter the number of plates contained in the selected stack.

Copy - If all stacks to be restacked contain the same number of plates, click the Copy button to
copy the settings from the first stack to the other stacks.

Plate — Ensure that the correct plate is selected from the drop-down list.

Import — If Read Barcodes (below) is checked, Import will display a dialog to allow you to locate
a barcode list text file.

Read Barcodes — |If this box is checked the barcodes buttons of selected stacks are enabled.

Barcodes — Click this button to enter barcodes for the current stack or to display a list of
barcodes allocated to the current stack.
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_i WellPlate Stack 1
Fead Barcodes Expected Barcodes
Mo |Barcode Mo [Barcode Add |
1 P11

5 s Remove
3 P33z
Irpart
4 Pa44 Q

5 PS54 Clear
Bl
Reverse

Cloze

Figure 18: WellPlate Stack Barcode Dialog

Add — Presents a new blank line to type in the next barcode.

Remove — Will the delete the selected barcode.

Import — Will display a dialog allowing a barcode list text file to be located.
Clear — Will clear all barcodes in the current list.

Reverse — Will reverse the order of the barcode list.

QTray Stacker

QSoft will check whether a tray stacker is configured for the robot. QTray stackers always have
two stacks. Each stack is represented on the form by a check box.

_if QSoft XP ReStackers

File Miew Help

@ &

Wislcome ] Wisllplate Stacker  QTray Stacker ] Start 1

- Select Stack(s] in use

]

- Enter number of trays loaded in each stack

w

- Select 'Read Barcodes' if barcode reading is required.

N

- If reading barcodes, select the carect tray type being
used in the stacker.

o

- [ barcode walidation is requited, use sither the Barcode
button for each stacker lane or the Import button to load
the validation barcodes.

QTray Stack 1 W Humber of Trays Loededt [5n = Barcodes
OTray Stack 2 ira Murnber of Trays Loaded: 150 ﬂ Barcodes

Copy I Irnpaort I

Ty |gTRAY |

Select Options 1 09-02-2004

Figure 19: QTray Stacker Options
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QTray Stack n - Check the box alongside each stack to be restacked. Stack 1 is always on the
right-hand side when facing the front of the robot.

Number of Trays Loaded - Enter the number of trays contained in the selected stack.

Copy - If all stacks to be restacked contain the same number of plates, click the Copy button to
copy the settings from the first stack to the other stacks.

Tray — Ensure that the correct tray is selected from the drop-down list.

Import — If Read Barcodes (below) is checked, Import will display a dialog to allow you to locate
a barcode list text file.

Read Barcodes - If this box is checked the barcodes buttons of selected stacks are enabled.

Barcodes - Click this button to enter barcodes for the current stack or to display a list of
barcodes allocated to the current stack.

_EE QTray Stack 1

Read Barcodes Expected B arcodes
Mo |Barcode Mo |Barcode Add |
1 111
5 252 Remove
3 323 Impaort
4

Clear
Reverse

Cloze

Figure 20: QTray Stack Barcode Dialog

Add — Presents a new blank line to type in the next barcode.

Remove — Will the delete the selected barcode.

Import — Will display a dialog allowing a barcode list text file to be located.
Clear — Will clear all barcodes in the current list.

Reverse — Will reverse the order of the barcode list.

Start

When all the required options have been set click the Start button.
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Contact Detalls

Corporate Headquarters
Genetix Ltd

Queensway, New Milton
Hampshire BH25 5NN, UK

Tel: +44 (0) 1425 624 600
Fax: +44 (0) 1425 624 700

Visit www.genetix.com for contact details of your nearest Genetix sales and support.

Trademarks

ClonePix™ FL, CloneSelect™ Imager, CellReporter™, HalfBD®, ‘NRich®, SlidePath™, Data Arena™ and Image Arena™ are trademarks
of Genetix Ltd., UK

CytoVision®, Ariol®, CytoNet® and CytoTalk® are registered trademarks of Genetix Corp

All third party trademarks are the property of their respective owners.
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